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Einfuhrung

SeaClear ist ein PC Rasterkarten-Plotter. An ein GPS angeschlossen, zeigt er das Schiff auf der Karte
und viele weitere Informationen im Navigationsfeld.

Die Karten in SeaClear sind Bitmap gerastert. Im Handel erhaltliche BSB/KAP und GEO/NOS
Digital-Karten oder vom Papieroriginal eingescannte, kdnnen verwendet werden.

Im Fahrbetrieb bewegt sich die Karte, um das Schiff immer anzeigen zu kénnen und weitere Karten
werden, wenn nétig geladen (falls diese Funktion gewahlt wurde).

Routen kénnen ganz einfach erstellt werden und helfen bei der Navigation. Bei Aktivierung einer
Route kann damit ein Autopilot angesteuert werden.

Tracks (Verlaufsspuren) kdnnen dargestellt, als Datei gespeichert oder als Route umgeschrieben
werden.

Waypts-Datenbanken mit Wegepunkten kénnen rasch abgerufen werden, um
Wegepunktinformationen zu erhalten oder eine Route zu erstellen.

Um so weit wie mdglich Platz fur Karten im Fenster zu haben, kann mit der rechten Maustaste ein
Popup-Meni mit den meisten Funktionen gedffnet werden.

Das "Dashboard", die Navigationsleiste zeigt Daten des GPS, der aktiven Route und weiterer Status
Informationen. Um das Kartenfeld zu erweitern kann diese Navigationsleiste weggeklappt werden.
Mit der Navigationsleiste werden viele Funktionen kontrolliert. Im Manuellen Modus kénnen Uber das
Hauptmend viele weitere Funktionen bearbeitet werden.

Falls keine GPS-Daten empfangen werden, kann Uber das “DR” Feld, direkt Geschwindigkeit und
Richtung eingegeben werden und SeaClear errechnet in “live”-Zeit die aktuelle Position. Mit dieser
Funktion ist auch Simulationsmodus mdglich. Sind tGber die NMEA Schnittstelle Bootsgeschwindigkeit
oder Kursdaten (Elektronischer Kompass) vorhanden, kdnnen diese Daten das DR-Feld aktualisieren.
Der Mouse-Zeiger verandert sich, um die jeweilig mogliche Funktion anzeigen zu kénnen.

Die Kopfzeile zeigt die geladene Karte, Mal3stab, Zoom und Anzahl der Entfernungsringe.

Die meisten Informationen kénnen ausgedruckt werden.

Alle Listen kdnnen direkt als eigene Dateien gespeichert werden.

AIS-Signale werden auf der Karte dargestellt sobald NMEA Daten von einem AIS Sender oder AIS
Empfanger Gbermittelt werden.

Beachte: Alle Hinweise fur SeaClear oder MapCal in dieser Anleitung basieren auf die aktuelle Version von SeaClear_2.EXE
und MapCal_2.EXE. Gegentber der alteren Version haben sich die Dateinamen geandert, um ein Miteinander im selben
Verzeichnis zu ermdglichen, wobei aber nur eine Kartenplotter.exe auf das GPS reagieren kann.
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Screen

— ——— Kopfzeile

;4—— Navigationsleiste
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GPS (Schiff)

: T Karte

Kartenfenster

Wegepunkt Marker Distanz Ringe wahre Fahrtrichtung GPS (Schiff)

Routen Wegepunkt Routen Linie Windpfeil



Navigationsleiste

File Tools >

GP-Diff
59*19.136 N
017°56.555 E

cog 223.2°

S0G 0.0kt
MagEn I2E
UTC 2000-07-24 13:42:34

Log 523.52
Trip 0.59
Haurs 7746

Positions

I jv

Find Position

Hauptmen(

Foutes
Open Route
Reverze Route
Actlivate Route
Foute Statistics
Start: WPH 0
End 'wWPH# 20
Dist: 9.84
Depth

2.81m
Wind
3537 0.6Ms
353°R 216°G
VP 0.0kt

Compasz

220.0°

&S Info  Find

DoubleClick

MeazLe Center

Shading
1 2 3 4

AUTOMATIC OFF
TRACK DFF

59°18.964 N
0757272 E
115° 0.A0NM
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GPS Status. Das Fenster wird [l dargestellt, falls keine GPS Daten eingehen
Latitude / Longitude

Wahrer Kurs Uber Grund

Geschwindigkeit Uber Grund

Computer berechnete Magnetische Missweisung / Welt-Zeit vom GPS
GPS basierendes Log

Trip

Software Laufzeituhr

Wegepunkt Datenbank

Wahle Wegepunkt

Finde diesen auf der Karten, lade neue Karte falls nétig

Routen Schnellbefehle

Statistik der benutzten Route

Tiefenanzeige. Bei Anschluss eines NMEA Tiefenmessers. Schaltet auf rot im
Alarmfall

Wind Informationen. Bei Anschluss eines NMEA Windmessers
Wahre Richtung und Geschwindigkeit
Relative und Geografische Richtung
Parallelberechnung zum Wind
Magnetischer Kompass. Bei Anschluss eines NMEA Elektronik-Kompass
AIS Informationen
Auswabhl eines AIS Zieles
Wahle Messen oder Zentrierung bei Doppelklicken der Maus in der Karte
Beim ,Messen® ist die Farbe Grun.
Beim ,Marker setzen® ist die Farbe [GY&H.
Wahle Nachtabdunkelung des Bildschirms

Klicke um den Automatikmodus Ein/Aus zu schalten (ESEIINEI Datei /
Bearbeiten verschwindet)

Klicke um den Trackmodus Ein/Aus zu schalten
Bei aktiver Route, klicke um NMEA Datenausgang Ein/Auszuschalten

Cursor / Messen / Marker Wegepunkt, Richtung und Entfernung.

Nur beim Anschluss der jeweiligen NMEA-Gerate werden die Datenfelder dargestellt. Auch ein
kleinerer Bildschirm kann die Anzeige begrenzen. Um alle Daten anzeigen zu kdnnen brauchen sie
einen 1024 x 768 Pixelbildschirm, sonst kdnnen diese nicht alle Felder dargestellt werden
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Planen mit SeaClear

Computer-Berechnete Navigation hat viele Vorteile. Der PC oder die bendtigten Dateien kénnen von
Bord genommen werden und eine weitere Planung kann in Ruhe, auf diesem oder einem anderen
Rechner, vorbereitet werden. Karten kdnnen schnell und einfach gescannt werden, wichtige
Wegepunkte bezeichnet und die nachste Route(n) sorgsam geplant und gespeichert werde.

Bedienung
W'T'lhrend der Planung muss der AUTOMATIK-Modus AUS sein. Der Cursor ist dann ein Kreuz.

I
Die Augenblickliche Cursorposition relativ zum Boot wird in der Navigationsleiste unten angezeigt.
Um die geladene Karte zu bewegen, klicken sie irgendwo in die Karte, halten die Linke Maustaste
und verschieben sie. Im “Center” Modus wird bei Doppelklicken die beste Karte flir den Cursorpunkt
geladen. Falls die Karte bereits die hdchste Aufldsung ist, wird sie erneut zentriert um ein rasches
Zurechfinden zu ermdglichen.

Bei “PC-Maus mit Rad” kann mit diesem schnell gezoomt werden. Dabei wird um die Mouse-
Position gezoomt.

Um Karten zu suchen, klicken sie rechts, dann in das Karten Menu und wahlen eine neue Karte.
QP%

Befindet der Cursor sich am Kartenrand, verandert er sich in ein Pfeilkreuz. 7 Es zeigt den

Karten-Such-Modus an. Mit einem Links Doppelklick, 1adt die Software die Anschlusskarte. Falls

nicht vorhanden ladt sie die Karte mit kleinerem MaRstab. Dies funktioniert auch im Messbetrieb
oder im Routen Editor Modus.

Klickt man auf das GPS Koordinatenfeld, wird auf der Karte das Boot zentriert. Sollte das Boot nicht
auf der aktuellen Karte sein, wird automatisch die beste Karte geladen. Doppelklicken in der Karte
ladt die beste Karte.

Falls “Messen” in der Nav-Leiste aktiviert ist, kann mit Doppelklick, Halten & Ziehen Entfernung und
Richtung gemessen werde. Dies wird in der Nav-Leiste unten (griin unterlegt) angezeigt.
Doppelklicke sie am Startpunkt und halten die Musetaste bis zum Zielpunkt gedrtickt. Im Automatik-
Ein-Modus ist Messen immer aktiviert.

Wahlt man im Wegepunkt-Meni einen Wegepunkt, wird dieser zentriert dargestellt. Ist er nicht auf
der aktuellen Karte wird die Beste flir diesen Punkt geladen. Unabhangig vom Suchen kénnen
Wegepunkte als neue Routenpunkte verwendet werden. Routen kénnen gewahlt werden und auch
mehrere kleine Routen als Gesamtroute zusammengefasst werden.

Routen, Wegepunkte und andere Informationen kdnnen ausgedruckt oder als Text-Dateien
gespeichert werden. Alle Listen werden als Komma-Getrennte-Dateien gesichert und kdnnen mit
vielen anderen Anwendungen gedffnet werden.

Wegepunkt (Waypoint)

Wegepunkte kdnnen gleichzeitig als “besonderen Punkt” oder als Routen-Wege-Punkt genutzt
werden. Damit verbunden kénnen Routen als Wegepunkte gedffnet werden, z.B. um Teile der Route
neu zu nutzen. Wichtig ist die Vergabe von Wegpunkt-Namen, wobei Namens-Duplikate nicht
moglich sind.

Karte 3
Um einen neuen Wegepunkt zu speichern, klicke sie die Bevorzugte Karte
rechte Maustaste an dieser Stelle auf der Karte und A B gk
wahlen Wegpunkt > Hinzufligen, tragen Wegepunktname Routen + ]
und evtl. weitere Infos ein. Nachbearbeitung bereits «+| I 2] AT gen
vorhandener Wegepunkte ist nach der Auswahl im Zoom ¥|  Fige moment, PSS hinzu
Positions-Fenster der Nav-Leiste méglich. Mit einem f;ﬁfg:; o Y effren
Doppelklick im Wegepunktnamen, oder nach Anwahl von _ Lssche Markisrung
Datei > Wegepunkte > Entsperre, ist es mdglich die \ Markiers Cursor
Position Weiterzuziehen und mit einem Doppelklick den A —

Editor zu 6ffnen. Zum Léschen muss nur die Rechte Maustaste gedruickt werden..
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Routen

Allgemein

Eine Route ist eine Aneinanderreihung von Wegepunkten, verbunden mit Geschwindigkeits- und
XTE Infos. Bei Aktivierung einer Route werden die wichtigsten Daten dazu in der Navigationsleiste
angezeigt.

Routenerstellung

Routen werden im Routen-Editor (Hauptmeni: Bearbeiten > Routen Editor) erstellt oder geandert.
Die Navigationsleiste andert sich fur Information von ausgewahlten Wegepunkten und
Schnellschaltern. Das Hauptmendi ist dabei verdeckt.

Beachte: Eine aktive Route muss vorher deaktiviert sein..
I (

Der Cursor wird dabei als Einflgemodus: I oder im erweiterten Modus: |l dargestellt.

Neue Wegepunkte werden einfach mit Doppelklick der linken Maustaste erstellt, oder kénnen der
bereits gespeicherten Waypts-Datei entnommen werden.

Wahrend dem Einfigemodus (normal) wird die Nachste, bereits Existierende mit dem neuen Punkt
verbunden. Vergessen sie dabei nicht die sofortige Namensbezeichnung und mit update zu
speichern. Im erweiterten Modus wird der Wegepunkt an das Ende der Route gehangt.

Nachtraglich bewegt werden kénnen die Wegepunkte durch einfaches Hineinklicken, halten und
verschieben zur Neuen Position (Wichtig: sofort update klicken falls sie den Namen andern).
Nachbearbeitet kénnen diese Wegepunkte im oberen Teil der Navigationsleiste werden. Mehrere
Wegepunkte kénnen mit der Ctrl-Taste oder der Shift-Taste angewahlt oder abgewahlt werden. Die
ausgewahlten Wegepunkte kdnnen geléscht oder nachbearbeitet werden. Wahrend der Anderung
von Mehrfach-Wegepunkten kdnnen aber keine Koordinaten oder leere Felder bearbeitet werden.
Dies ist aber im Route-Listen Feld méglich.

Wahrend der Routen Editor aktiv ist, sieht die Navigationsleiste so aus:

File »» Routen Hauptmeni
R oute "W aypoint Ausgewabhlte Positions-Datei
Alsten - Liste von Wegepunkten

Lat [59713100N Position Latitude
Long[17°56.453 € Position Longitude

I .00 5
Speed Geschatzte Geschwindigkeit

HTEMax I 0.050 Ev Max Kursversatz

t ame

I.éqlxten

Wegepunktname
Update

Update sofort nach jeder Anderung
Delete Selected .
Lésche Auswahl

Dpen Route
Schnellschalter
Save Route
Clear Route
List Houte

Close Editor

Add Fosition Flge ausgewahlte Wegepunkte an die Route

Positions

I j' Waypoint Datei

Find Position

Route Statistics

Start: Alsten o
End: Kungshatt Geladene Routen Statistik

Dist: 2,79

Wenn ein Wegepunkt aus der Liste gewahlt wird, ist dieser sofort zentriert auf dem Kartenbildschirm
dargestellt. Befindet er sich nicht auf der momentanen Karte, wird die best mdgliche Karte dafir
geladen.

BEACHTE: Wahrend der Arbeit im Routen Editor werden die GPS Daten weiterhin von SeaClear verarbeitet..
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Navigieren mit SeaClear

Bevor ein Toérn begonnen wird, sollte die benétigte Route geladen werden. Nun ist es mdglich
SeaClear unabhangig arbeiten zu lassen und sie haben Zeit fir andere Arbeiten. Wahrend der
Navigation kann der AUTOMATIK-Modus aktiviert werden. Die Karte wird dabei stdndig neu
verschoben und auch weitere Karten automatisch geladen, um das Schiff standig im Kartenmittelpunkt
(falls gewahlt) zu sehen.

Falls eine Route geladen wurde, aktivieren sie diese um weitere Information zu erhalten. Ist das
Tracking aktiviert, wird die Trackspur eingezeichnet und automatisch gespeichert.

Im AUTOMATIK-Modus ist der Cursor der gewohnte Pfeil.

Navigation mit Routen

Laden sie, bevor ein Térn begonnen wird, die nétige Route (n). Mehrere Routen kénnen ausgewahit
werden und jede weitere Route wird an bestmadglicher Position angehangt. Gleichzeitig mehrere
Routen kénnen mit der Shift-Taste ausgewahlt werden.

Bei einer Aktivierung im letzten Teilstuck einer Route wird diese automatisch umgekehrt. Ist das Boot
nicht am Start- oder Zielpunkt wird von der momentanen Position aus gerechnet.

Falls die Route aktiviert ist, wird der neue Zwischen-Ziel-Punkt hervorgehoben (Rechteck) und in der
Navigationsleiste erscheinen dazu weitere Daten. Istim AUTOMATIK EIN-Modus der “NMEA OUT -
Schalter aktiviert, werden die im Setup ausgewahlten Datensatze an externe Gerate (z.B. Autopilot)
geschickt:

Wegepunktname

by BWR: Kurssteuerung zum Wegepunkt, Rumb Line

B/H 182.2° XTE: Kursversatz

#TE 0.04NMH ' o _

BEOD 167.0° BOD: Routen-Original-Kurs zwischen den Wegepunkten,
ﬁ'-.-" 0.0kt WCV: Wegepunkt Annéherungsgeschwindikeit

BMG 0.1NH RNG: Entfernung zum Wegepunkt,

E 99:59:59 TTG: Zeit bis zum Wegepunkt,

TERMG 9.9HH TRNG: Entfernung zum Routenzielpunkt,

TG 99:59:59 TTTG: Gesamtzeit bei aktueller Geschwindigkeit zum Ziel.
M 216.5" NEXT: Néchster Kurs.

M 00:00:56 TIME: Zeitanzeige seit die Route aktiv ist.
o o T _Jl____: Steueranzeige.

Um zwischen “Wahrer” und Magnetischer” Kursanzeige zu wechseln, 6ffnet man mit einem
Rechtsklick das Popup-Fenster auf die Routeninformationen.

Bei Uberschreiten des eingestellten XTE-Wertes (Kursversatz), wird er [ dargestellt.

Wird der nachste Wegepunkt Uber- oder umfahren, aktiviert sich der Nachste. Im AUTOMATIK-
Mode muss (Einstellungen?), dies tber ein Rechtsklicken im Popup-Menl > Route bestatig werden.
Wenn der AUTOMATIK-Modus EINgeschalten ist und die Route aktiviert, steht das Hauptmen
nicht zur Verfligung. Ebenfalls ist das Wegepunkt-Fenster verschwunden und Anderungen von
Wegpunkten sind momentan nicht méglich. Die meisten Schnell-Schalter sowie das Zoomen sind
dagegen in Funktion. Fiir eine Ubersicht kann mit Ctrl-S eine Uberfliegerkarte geladen werden.
Diese schaltet automatisch nach 20 Sekunden auf die beste verfligbare Karte zurick.

Um die Route zu deaktivieren klicken sie rechts das Popupmeni Route > Route aktivieren.

Tracks (Verlaufsspur)

Falls das Tracking aktiviert ist, wird die Trackspur des Bootes bis 0 Uhr aufgezeichnet und
permanent gespeichert. Ab 0 Uhr beginnt eine neue Datei, die Alte kann aber nachgeladen werden,
wobei dazu das Momentan-Tracking Abgeschalten werden muss. Folgende Daten werden
gespeichert: Datum, Zeit, Positionen, Kurs und Geschwindigkeit. Der Track Intervall kann Uber das
Kartenreiter ,Log + track® in Bearbeiten > Einstellungen verandert werden. Die Trackdatei erhalt
automatisch ein ANSI Format mit Datumsangabe (z.B. 20060304.TRC = Jahr 2006, Monat 03, Tag
04 = 04.03.2002). Die Trackdateien kdnnen ausgedruckt oder exportiert werden. Diese Dateien
kénnen auch als neue Route verwendet werden oder in Google Earth dargestellt werden.

10
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Logbook

Ein elektronisches Logbuch speichert bei Offnen automatisch Zeit und Position. Selbsterstellte
Textteile kbnnen daran angehangt werden. Automatische Eintrage, Pfad und Logbuchname werden
Uber Bearbeiten > Einstellungen eingestellt. Mit jedem Texteditor kann sie gelesen werden.

Kartengruppen

Um Digitale Seekarten besser organisieren zu kénnen ermdéglicht SeaClear Kartengruppen. Sie sind
optional. Falls keine Gruppe erstellt und gewahlt ist, werden stéandig alle Karten durchsucht.
Waéhrend eines Suchbefehles werden Karten dieser Gruppen vorrangig gefunden und angezeigt —
ansonst werden alle Karten aufgefiihrt. Unabhangig vom Mal3stab werden alle Karten in einer
gewahlten Gruppe angezeigt.

Bis zu 24 Gruppen kdnnen erstellt werden. Mehrfachzuweisungen einer Karte sind maoglich.
Gruppen erleichtern das Auffinden einer besonderen Karte, die auch automatisch fiir Planungen
(AUTOMATIK AUS) geladen werden kann.

Die bevorzugten Gruppen im AUTOMATIK-Modus und dem Planungsmodus sind unabhangig und
erlauben verschiedene Karten im Planungsmodus zu 6ffnen, ohne sich im AUTOMATIK-Modus
auszuwirken.

Erstellen und Gebrauch von Kartengruppen

Um eine Kartengruppe zu erstellen wird Uber das Hauptmeni Bearbeiten > Kartengruppe ein
Dialogfenster geoffnet.

Um Gruppen nutzen zu kdnnen muissen sie vorher im Gruppen Setup erstellt werden. Bendétigte
Karten fur eine Gruppe werden im Verwalte die Karten-Fenster durch Auswahl der Gruppe
angezeigt. Wahlen sie hier nun mit CTRL oder Shift-Taste alle gewlinschten Karten aus und
schicken sie mit dem Mittelpfeil in die gewlnschte Gruppe.

¥erwalte Kartengruppen Bevorzugte Autoload-
Yenwalte die Karten ] Lade K.artengruppen automatisch | Gruppen Setup | Kartengruppen werden in diesem
Yorhandene Kartengruppen Directorny Filter Fenster aUSgewahlt- Ist der
Adria j |C:'\Navigate\SeaCIeal\charts\Med\.f-‘-.dria'\j AUTOMATIK-Mode akthIert,
Karten in Gruppen Zur Verfligung stehende Farten kdnnen bevorzugte Karten Uber
A0 _LignanoGrado Adria N B das Popup-Menl geladen werden.
A02_CanalediPrimeroT riesePortorocmag Adna MME
AU3_MovigradPorecR oving Adria Mord Ost Im Planunasmodus werden
A0 PulaPomerZalievB aza Albaria 9 .
A5 FvamerCresnordBieka Albaria, Durres Harbaor bEVOFZUgte Karten mit einem

m

Albaria, Viores i
g Bani-Eufemia, Italien Doppelklick geladen.
Boticelo-dlice, Italisn Beim Gebrauch der Popup-
Erindiz_parta R
3, |BrindisiBa Italen Funktion Karten > Suchen sorgt
proatia eine Vorauswahl fiir schnelles
Croatia South Auffinden.
Croat!a, DL_Jbrovmk ] .
Eroa:!a, Ef,;m-s,:en'sp"‘ d Um alle Karten zu aktivieren,
roatia, Sibeni ..
AD5_KvamerCresnordRijeka 1:50000 mussen nur a"e pevorzugten
C:AMavigatehSeaClearschartzs'MedWhdia\adia2004 Lignano-Zadara05_KvamerCresnondRijeka W C Gru ppen deaktiviert werden. Auch

nach dem Deaktivieren kann
individuell in Gruppen gesucht
werden.

Losche Ok

Die Kartenrandlinie zeigt, vom Malstab abhangig, verfligbare Karten auf dem Bildschirm oder einem
Ausdruck. Um aber alle Karten anzeigen zu kénnen, miissen alle Gruppen deaktiviert werden.

Die im MapCal neu kalibrierten oder gefundenen Karten werden nicht automatisch einer Gruppe
zugeordnet, kdnnen aber nachtraglich in ein Gruppe eingefiigt werden.

Im Popup-Menl Karte > An dieser Position werden alle, fiir diese Position moglichen Karten,
Gruppenunabhangig angezeigt.
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Menlus

Meniumaoglichkeiten sind vom gewahlten Modus abhangig. Im Planungsmodus ist das Hauptmenti
verfligbar. Hier kbnnen Dateien geladen werden die zur momentanen Position keinen Bezug haben.
Popup Mends, die mit der Rechten Maustaste aktiviert werden, lassen einen schnellen Zugriff auf
viele Funktionen zu, abhangig welches Menu gerade aktiviert ist.

Normaler Planungsmodus Hauptmenii:

Datei
Karte:

Zeige Alle. Zeigt alle Karten der Autoload Liste.
Suchen: Offnet den erweiterten Suchdialog.
Letzte. Ladt die zuletzt verwendete Karte.

O O o o

Nicht Aufgefiihrte. Offnet Karten die nicht in der Autoload Liste aufgefiihrt sind. Sie miissen kalibriert sein.

0 Kartenrand: Zeichnet eine Randlinie aller verfligbaren Karten auf der verwendeten Karte. Nur Karten der
Autoload Datenbank werden dargestellt. Karten desselben Maf3stabs und bis zu 50 x kleinere werden
dargestellt (dies kann im Setup verandert werden) Die Randlinie, ist der Rand der beim Kalibrieren gespeichert
wurde. Sind die Karten in Gruppen abgelegt, werden nur bevorzugte Gruppenkarten angezeigt.

O Drucke: Uber einen Drucker kann die geladene Karte ausgedruckt werden. Routen, Wegepunkte, Track und
Kartenrandlinien kénnen dabei nach Auswahl mit ausgedruckt werden... Auch Routenangaben und
Wegpunktinformationen kénnen als Liste ausgedruckt werden. Der Druckbereich bei Karten, kann der
Bildschirmbereich oder die ganze Karte sein. Die Druckeransteuerung ist auf maximales Papierformat
eingestellt, die Voreinstellungen des Druckers werden dabei ignoriert.

O Drucke Liste: Druckt eine Liste aller Karten mit Eckkoordinaten und Malstab.
Route:

0 Offne. Offnet eine neue vorbereitete Route. Es kénnen mit der CTRL-Taste auch mehrer ausgewahlt und
gleichzeitig gedffnet werden.

O SchlieRRe. Loscht eine Route vom Bildschirm

O Export NMEA. Sendet alle Wegepunkt als NMEA-Datensatz tiber den Com Port als WPL und RTE Report.
O Drucke. Druckt die geladene Routenliste.

Wegepunkt:

0 Offne. Eine oder mehrere Waypts-Dateien kénnen, mit Halten der CTRL-Taste gedffnet werden.

0 Beachte: Jede Waypts-Datei bendtigt einen eigenen Dateinamen.

O Speichere: Speichert den Wegepunkt in der gedffneten Datei.

O Speichere als: Offnet ein Pfadfenster in dem das Verzeichnis (normal ist ..\\Waypts) und der Dateiname
gewahlt werden kann.

O SchliefRe. Loscht alle aktuellen Wegpunkte vom Bildschirm (nicht aus der Datei). Entsperre. Erlaubt eine
Auswahl, Verschieben und Ldschen von Wegepunkten (nicht aber im AUTOMATIK ON Modus oder Routen
Editor).

O Loésche Auswahl Import WP+: importiert Komma-Getrennte Wegepunktdateien mit *.txt Endung Export
WP+: exportiert Komma-Getrennte Wegepunktdateien mit *.txt Endung

O Export NMEA. Sendet alle Wegepunkt als WPL Report.

O Drucke. Druckt eine Liste der geladenen Wegepunkte.

Track:

O Offne alten Track. Offnet einen bereits gespeicherten Track und stellt ihn dar.
O Import WP+. Wandelt eine WP+ Track Datei in SeaClear Format.

O Export Text. Sichert den momentan angezeigten Track als Komma-Getrennte Text Datei. Zeit, Position,
Geschwindigkeit und Tiefe werden gespeichert. Positionen werden dabei als Dezimal-Grad-Werte gespeichert
um leichter in anderen Programmen verarbeitet werden zu kdnnen.

O Drucke. Druckt je nach Auswahl einen aktiven oder alteren Track als Liste.
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GPS:

O Dieses Menu steht nur zur Verfliigung wenn die G7ToWin Software installiert ist.

0 Sende an das GPS — Wegepunkt oder Route. Sendet ausgewahlte Daten an das GPS.
0 Lade vom GPS — Wegepunkte, Route oder Track. Ladt Daten vom GPS.

Karten info: Zeigt Zusatzinformationen zur geladenen Karte.
SchlieBe: Beendet SeaClear.

Routen Editor Hauptmenii:

Nacht Modus:

0 Wahlt den Abdunkelungsgrad des Bildschirmes. 1 ist normal, 4 ist maximale Abdunkelung.
Routen Editor:

0 Offnet den Routen Editor.

Einstellungen:

0 Offnet das Optionssetup.

Kartengruppen:

0 Offnet das Kartengruppensetup.

System:

O NMEA Input Monitor. Schaltet das NMEA input Ansichtsfenster ein/aus.

O NMEA Output Monitor. Schaltet das NMEA output Ansichtsfenster ein/aus.
tber...

Offnet das SeaClear Info-Fenster.

>>

Klappt die Navigationsleiste weg um den ganzen Bildschirm als Kartenfenster zu nutzen. Um die
Navigationsleiste wieder anzuzeigen, fahre sie mit der Mouse nur zum jeweiligen Rand.

Routen Editor Hauptmeniu:

Dateimenii
Route:

0 Offne: Offnet eine neue bereits erstellte Route. Mehrere Routen kénnen mit CTRL-Taste gleichzeitig
geoffnet werden.

0 Speichere: Speichert Anderungen unter dem bestehenden Dateinamen. Sind mehrere Routen gedffnet
muss ein neuer Dateiname vergeben werden.

Speichere als...: Speichere als neue Route.

Import Track. Ladt einen bereits gespeicherten Track.

Import. Waypoint+ und G7ToWin Datei import.

Export. Waypoint+ und G7ToWin Datei export.

Export NMEA: Sende WPL und RTE Dateien an angeschlossene NMEA Teilnehmer (z.B. Autopilot).
Routenliste: Offnet die aktuelle Routenliste.

Routenumkehr: Vertauscht Start und Zielpunkt.

Lésche Route: Entfernt die aktuelle Route vom Bildschirm.

O 0o ooooogo

Drucke: Druckt eine Routenliste.
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Offne Karte:

O Zeige Alle: Zeigt alle Karten die in der Autoload Liste gespeichert sind.
O Letzte: Offnet die zuletzt verwendete Karte.

O Nicht aufgefiihrte: Offnet Karten die nicht in der Autoload Liste stehen.

0 Kartenrand: Schaltet den Kartenrandrahmen ein/aus. Es kénnen nur Karten der Autoload Datenbank
angezeigt werden.

Offne Wegepunkt:
Offnete eine neue Wegepunktdatei. -

Beva ZI.IgtE Katke

. Routen L4

Popup Meniis Wegepunkt r
Die rechte Maustaste aktiviert Popup Menus. An der aktivierten £oom d

Bearbeiten k

Cursorposition sind nun verschiedene Funktionen moglich, die auch
teilweise im Hauptmeni abgerufen werden konnen. 1 MARKIERE MOB

Bevorzugte Karten:

Wahlt bevorzugte Mal3stabe, die im AUTOMATIK- sowie Planungsmodus gewilinscht werden, oder
I&dt bevorzugte Kartengruppen, bei Doppelklick im Kartenfenster. Im AUTOMATIK-Modus werden
die bevorzugen Kartengruppen aufgefiihrt. Dabei wird die Karte mit grof3tem Mafstab gewahlt. Mit
den Up/Down Pfeiltasten kann gewechselt werden, “M” steht fir maximalen Malstab, Esc verlasst
das Fenster ohne Anderung. Als “Beste Karte” im Menii wird die Karte mit dem gréRten MaRstab
behandelt.

Karten:

(Nicht méglich im AUTOMATIC Modus).

Beste Karte: Findet und |I&dt die beste, an dieser Position verfligbare Karte.

Finde Boot: Findet das Boot und Iadt die beste Karte dafir.

Kleinerer Mal¥stab: Wahlt eine Karten mit kleinerem MaRstab fir diese Position.
Vorherige: Schaltet zur zuletzt geladenen Karte zurtck.

An dieser Position: Alle an dieser Position verfugbaren Karten werden aufgelistet.
Suche: Offnet ein erweitertes Suchfenster fir Karten.

O 0Ooogoooo g

Alle Karten: Alle installierten Karten werden aufgefiihrt..

Routen:

O Offne Route: Alle bereits gespeicherten Routen werden aufgefiihrt.

O Routenumkehr: Dreht die Route um und verwandelt den Start- in den Zielpunkt.

O Aktiviere Route: Aktiviert die geladene Route und zeigt Routeninformation auf der Navigationsleiste.
Wegepunkte:

Hinzufligen: Fugt einen Wegepunkt an die momentane Cursorposition.

Momentane Pos. hinzufligen: Erstellt einen Wegepunkt an der augenblicklichen Bootsposition.

Losche Marker: Loscht den Marker.

O O o o

Setze Marker: Setzt einen Marker an die Cursorposition.

O Ist ein Marker platziert, zeigt das Marker/Cursor-Fenster dessen Position, Entfernung und Richtung vom
Boot aus.

Zoom:

Zoom mit einem festen %-Wert. Bei einigen PC-Systemen kann zoomen die Kartendarstellung
dramatisch verlangsamen, andere reagieren darauf kaum. Zoomen in Zwischenschritten s.
Shortcuts.

Bearbeiten:

O Logbucheintrag: Erméglicht einen eigenen Logbucheintrag.

O Alter Track: Ladt einen alten Track ins Kartenfenster.

0 DR Update. Offnet das “Dead Reckoning” Fenster. Dies ist nicht méglich wenn ein GPS angeschlossen ist.
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0 Erneuere Bildschirm. Ladt die aktuelle Ansicht erneut.

O Einstellungen: Offnet das Programm-Setup-Fenster.
O Schliele. Beendet SeaClear.

MARKIERE MOB:
Setzt den Marker an die momentane Bootsposition.

Routen Popup Menu

Wenn im Routenmen die rechte Maustaste gedriickt wird, ist folgende Auswahl mdglich:

0 Beste Karte: Die beste Karte an der Cursorposition wird geladen.

Mehr Karten: Zeigt weitere Karten an.

0
O Erweitert: Alle Routenwegepunkte werden aufgezeigt.
a

Zoom: Stellt den Zoomfaktor ein.

Beachte: Einige Funktionen sind im AUTOMATIK-Modus oder dem Routen Editor nicht mdglich.

Tastatur Kurzbefehle Shortcuts

Tastaturbefehle werden mit Ctrl (Strg) + Taste oder Funktionstasten gegeben.

Ctrl+'X": Zoom heraus

Ctrl+'Z": Zoom hinein

Ctrl+'A" oder F2:
Ctrl+'T' oder F3:
Ctrl+'P' oder F4:
Ctrl+'N' oder F5:
Ctrl+'H' oder F6:
Ctrl+'L’ oder F7:
Ctrl+'C’ oder F8:
Ctrl+'B' oder F9:

Automatik Ein/Aus

Tracking Ein/Aus

NMEA Out Ein/Aus

Neuen Wegpunkt bestatigen (falls im Setup gewahlt)
Lésche Marker

Logbucheintrag

Bevorzugter Kartenmalistab

Finde das Boot und lade beste Karte

CtrI+'F'": Finde das Boot auf der momentanen Karte

Ctrl+'S' oder F10: Kleinerer Kartenmafstab (Im AUTOMATIC-Modus nur fur 20 Sekunden)

Ctrl+Q: Karte fir diese Position. Im AUTOMATIC-Modus fiir die GPS Position

Ctrl+'V' oder F11: Zuletzt geladene Karte laden

Ctrl+’O’ oder F12: Kartenrand Ein/Aus

Ctrl+'D": Navigationsleiste Anzeigen/Wegklappen

Ctrl+'1": Normale Bildschirmhelligkeit

Ctrl+'2": Abgedunkelte Bildschirmhelligkeit (2)

Ctrl+'3": Abgedunkelte Bildschirmhelligkeit (3)

Ctrl+'4': Nacht Bildschirmhelligkeit
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H Katte 4
E I nSteI I u n ge n 14 Bewvorzugte Karke e
Allgemein Routen '
‘Wegepunkt 4
Im Optionsment kdnnen verschiedene Einstellungen e .| Zoom ,
vorgenommen werden, auf die mit dem Popup- oder Loghuch Eintrag Bearbeiten r
Hauptmeni zugegriffen werden kann. Ein Verzeichnis- | Setze DR Pos MARKIERE MOE
Setup und Kartensuche muss in MapCal durchgefiihrt ALS Info T
werden. Meuer Bildschirmaufbau R “
Einstellungen L\\"‘g -z
23 -+
J Schliefie . ;fi‘\
Anzeige '
Boot:
Update Intervall: Bildschirm update Intervall fiir das Boot
Farbe: Farbe fur den Bootsmarker und Geschwindigkeitsring.
GroRe: GréRe des Bootmarkers.
Radar Ringe: Anzahl der sichtbaren Radar Ringe.
Ring Abstand: Entfernung zwischen den Ringen, oder Autowahl fur die Mal3stabanpassung
Speed Marker: Anzahl der Sekunden vor dem Geschwindigkeitsring. Ist bei 0 abgeschaltet.
Sprache:
Sprachendatei: Wabhle sie eine Sprache. Siehe dazu den Sprachen-Teil.

Bildschirmanzeige:
Navigationsleiste: Linke oder Rechte Seite.

Zoom mit Mausrad: Ein/Aus.

Blicke vorwarts: Ein = in Fahrtrichtung wird der grofRere Kartenteil angezeigt.
Aus = das Schiff wird auf der Karte zentriert dargestellt.

Update ohne GPS: Berechnet Uber das DR Feld die letzten NMEA Daten weiter.

Dicker Cursor: Nutzt einen grélReren, sichtbareren Cursor.

Karte:

Kartenvorschau: Zeit fur eine Kartenvorschau im AUTOMATIK-Modus.

Roll Kartenrand: Kartenrahmen an dem mit Doppelklicken Anschlusskarten gefunden werden.

Neuer Kartenzoom: 100% oder zuletzt genutzter Zoom.

Route

Néachster Wegepunkt

Nachster Wpt. Zeiteinstellung vor dem Erreichen eines Wpt. um den Nachsten zu aktivieren.

Max. Abweichung. Distanzabweichung zum aktiven Wegepunkt, falls das Boot einen anderen
Kurs fahrt, als die Vorgaberoute und ein neuer Zwischenstarpunkt kalkuliert
wird.

Bestatige neuen Wpt: Falls gewahlt, muss bei Erreichen eines Wpt., das nun rote Routenfeld mit
einem Rechtsklick im Routenfeld oder der Tastatur (F5) bestatigt werden.

Routen Normalangaben

Geschwindigkeit: Die erwartete Geschwindigkeit beim Erstellen eines Wegepunktes.
XTE max.: Die erwartete XTE maximal Abweichung des obigen Wegepunktes.
Routenanzeige

Normale Farbe: Farbwahl fur die normale Anzeige eines Wegepunktes.
Ausgewahlte Farbe:  Farbwahl fiir die Hervorhebung eines Wegepunktes.

Grole: Marker GroRe.

Linienstarke: Wahl der Linienstéarke.

Zeige Wegepunktinfo Zeigt den Wegepunktnamen, falls vergeben, auf der Karte.
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Logbuch + Track

Tracking Intervall:
Eintrage der Angaben, wie oft die Bootsposition in der Track-Datei gespeichert wird.

Min. Zeit. Zwischen jedem Trackpunkt. 0 ist kein Eintrag.
Min. Entfernung In Metern. 0 ist kein Eintrag.
Kurswechsel In Grad. 0 ist kein Eintrag.

All Angaben, ausgenommen 0-Werte missen vor der Aufzeichnung gemacht werden.

Track Anzeige:

Track Farbe.
Track Darstellungsbreite .

Log Buch:

Automatische Eintrage Was wir automatisch im Logbuch festgehalten. Wahlen sie!
Logbuch-Datei. Dateiname und Pfad fur das Logbuch..

Instrumente

Tiefen Anzeige:

Zeige Tiefe: Ein/Aus.

Tiefen Alarm. Bei Unterschreitung des eingestellten Wertes gibt die Anzeige Alarm.
Messgeber Tiefe: Gebertiefe unter der Wasserlinie. Wird zur Gesamttiefe addiert.
Wind Anzeige:

Zeige Wind Daten: Ein/Aus.

Arrow Color: Wabhle die Farbe des Windpfeiles, der Richtung und Starke angibt. 0-1 kt

ohne Anzeige, 1-8 kt duinn, 8-15 kt 2 Pixel groR, 15-22 kt 3 Pixel grof3, >22 kt
ist ein 4 Pixel dicker Windpfeil.

Kompass Anzeige:

Zeigt die NMEA Daten eines Elektronischen Kompasses.

Log Daten:

Gebraucht GPS fur Log und Trip Kalkulation.

Zeige Log und Trip. Falls gewanhlt, werden diese Daten im GPS Feld aufaddiert.

Schalte Log AUS. Falls die Geschwindigkeit unter den eingestellten Wert sinkt werden Log und
Tripdaten nicht aktualisiert.

AlS:
AlS
Show AIS Targets: Schaltet die AIS Darstellung An/Aus.
Show AIS Panel: Zeigt die AIS Anzeige in der Show A5 Targets [
. . . . . ) Show &5 Panel -
Navigationsleiste (im Automaticmodus = keine Darstellung) Show Labels =
Show AIS Labels: Zeigt die AlIS Signalgeber mit Namen auf
CP& Max 010 =) N
der Karte. =
CPA Max: Entfernungsgrenze fiir die CPA Warnung. TR e 150 2] Min
TCPA Max: Zeitbegrenzung als Anzeige fir eine CPA Target Calar -
Warnung. Abgeschaltet beim Wert 0 Target Size Medium
Target Color: Farbe fir AIS Signale.
Target Size: Signalgrofie.

Beachte: Tiefe, Wind, AIS und Kompass miissen NMEA kompatibel sein und lber einen Multiplexer an den PC
weitergegeben werden, sonst werden die Felder nicht angezeigt.
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Comm

NMEA Verbindung:

PC Port. Com 1 - 256. Wird gleichzeitig fir Senden und Empfangen genutzt.
BPS: Bit rate Einstellung. NMEA ist gewdhnlich 4800.

Beachte: SeaClear empfiangt Daten von bis zu 3 Eingéngen (com ports). NMEA Durchlauf (Pass-through) kann genutzt
werden damit SeaClear Daten nur filtert (multiplexer). So kann z.B. ein USB GPS fir die Position genutzt und tber den
Seriellen Anschluss der Autopilot angesteuert werden.

GPS Datum:

Muss auf das geodetic datum des GPS eingestellt sein — im Regelfall WGS 84. Wahlen sie aus der
Liste.

NMEA DR Update:

Sollten die GPS-Daten ausfallen und NMEA-Daten fir Geschwindigkeit und Elektro-Kompass
vorliegen, werden diese in der DR Anzeige verarbeitet. Diese Geloggten Daten werden fir eine
grobe Kalkulation von SeaClear verwendet bis wieder GPS Daten einen exakten Fix ermdglichen.

NMEA Durchgang:

Daten die sofort weitergereicht werden. Diese Daten werden Uber die Funktion NMEA OUT EIN/AUS
gesendet. Von SeaClear erstellte Daten durfen nicht aufgefihrt werden.

NMEA Ausgang:

Wenn die Route aktiviert ist und “NMEA OUT ON” gewahlt ist, werden die berechneten
Routendaten Ubermittelt.

Datensatze: Wahlen Sie welche Daten an einen Autopilot, Radargerat oder weiter NMEA-
Gerate, abhangig von ihrem Input gesendet werden sollen. WPL + RTE wird
dabei nur gesendet wenn aktiviert, alle anderen Meldungen werden im
Zeitinterval der Auswahl gesendet. Der “Export NMEA” wird fiir Datei > Route
der Datei >Wegepunkt genutzt, unabhangig vom NMEA Output Schalter.

Ubertragungsart: Wegepunkt-Namen werden vor der Ubertragung gefiltert. “Upper Case” sollte
mit den meisten Geraten funktionieren, die eine NMEA Input Datensatz
akzeptieren. “+Lower Case” erlaubt ASCII Zeichen (>128). “As Is” Gbermittelt
den Text als Windows ANSI standard 8 bit. “Numeric” sendet nur Wegpunkt
numeric id und sollte selbst mit alteren Geraten die NMEA input unterstitzen,
funktionieren. Diese Einstellungen beeinflusst, was von einer Route- oder
Wegepunk Datei mit Export an NMEA Ubermittelt und wie sie als WP+ oder
G7ToWin gespeichert wird. "Nexus" Ubermittelt Daten in das Silva Nexus und

NX2 Format.
Update Intervall. Intervallzeit - wie oft die NMEA Daten tbermittelt werden.
XTE Ampl. Faktor.  Der XTE-Versatz dient  [seaclear setup
dem Autopiloten um Anzsigs | Routs | Log + Track | Instrumerts Com | Anders |
einen genaueren Kurs :
halten zu kénnen und e S
Tw/Rel | Rx2 Rx3 = -
dem “Schlangenkurs” APB -
vorzubeugen. Dabei G Conft =] & s -
0, .
100% 1:11. BRS [800 <] we u
NMEA Id. NMEA Talker N e cce S
Identification, immer 2 GPS Daatum Einstelung
Buchstaben. Normal ist = UpdateInerval 5 3.
“EC” Oder "G P"_ RTE Abweichungsfaktor o3 o
Speichere WP Id: Ein/Aus. Falls Ein, Lhillodals NMEA o Ee
gesperrte Wpt-Namen IR DR e r Speichers WP 1d r
werden fur alle NMEA Durchgang
Routenteilstiicke
genutzt. Nétig evtl. fur e — Schiishe
einige Geréate die sonst

eine Bestéatigung
erfordern.
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Andere

Alarmton An:

SeaClear MMV

Gebraucht die gewahlte Alarmton Sound Datei der win.ini Datei.

Startup:
Aktualisiere PC ...

Lade letzte Wpt...
Lade letzte Route:

Wegepunkte:
Normale Farbe:

Ausgewahlte Farbe:
Grole:

Nutzt die sehr exakte GPS Zeit um die PC Systemzeit zu aktualisieren.
Ladt die zuletzt verwendete Wegepunkt Datei (auch ungespeicherte)
Ladt die zuletzt verwendete Route (auch eine ungespeicherte).

Farbe der Normalanzeige von Wegepunkten.
Farbe flir Hervorgehobene Anzeige von Wegepunkten.
MarkergroRe.

Zeige Wegepunkt Info: Zeigt den Wegepunktnamen auf der Karte.

Nacht-Abdunkelungs-Modus.
Wahlt die Abdunkelung und was.

Filter 2-4:

Wahlt die Abdunkelung in % fiir jeden Filter. In % von -95 bis 95, wobei 0
keine und 95 der dunkelste Filter ist. Ein Negativ % Filter wird vor dem
abdunkeln invertiert.

Gesamter Bildschirm: Verdunkelt nicht nur die Karten sondern den ganzen Bildschirm.

Karten-Rand-Linie.
Farbe:

Max. MaRstab:

Wahlt die Farbe der Karten —rand- Linie.

Welche Karte soll angezeigt werden? Bei 20 werden Karten mit dem Malstab
1-20 * der geladenen Karte angezeigt.

SeaClear Setup

Alarrntan

Stark

.ﬁ.nzeige] Hn:nute] Lag + Track Instrumente] Com  Andere

W egepurkt

[ Marmale Farbe /-
Auzgewshite Farbe B -
Giraie hdittel -

Aktualliziere PC-System-Leit mit GPS v
Lade Letze wWegepunkt-Dratei [
Lade Letze Route v

T ag/Macht Bildzchirm
Filter [2] Filter [3] Filter [4]

G i

Gezamter Bildzchim L} [

zeige Wegepunkt Info

K.artenrand-Linie

Farbe

b ax. M alistab

Speichere

Schliefe
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Installieren von Karten
MapcCal

Um neue Karten zu installieren oder existierende nachzukalibrieren, nutzt man MapCal_2.exe. Eine
gerastete Bitmap Bilddatei und Kalibrationswerte sind nétig um eine Geografische Adresse
darzustellen. Mindestens 2 Kalibrationspunkte sind dazu nétig. Um die Kalibration zu priifen kann
ein Gitternetz darlber gelegt werden. Ein neu definierter Kartenrand rahmt den nutzbaren
Kartenbereich firr eine Automatische Auswahl. Beides, Gitternetz und Rahmen nutzen den
eingestellten Malstab.

Bild- Dateien (PNG, BMP...) bendtigen eine eigene Kalibrationsdatei, wahrend bei WCI diese direkt
in der Bild-Datei abgelegt sind. BSB/KAP und GEO/NOS Dateien sind vorkalibriert und kdnnen nicht
mit MapCal geandert werden. Es ist aber mdglich sie zu 6ffnen und die Koordinaten zu prufen.
Frihere Versionen von SeaClear nutzten eine andere Art von Kalibration, diese kann aber in das
neue Format umgeschrieben werden.

OziExplorer *.map Dateien kdénnen mit Bild und Kalibrationsdaten importiert werden. Beachte, das
*.map Dateien keine visuellen Referenzpunkte hat und der MaRRstab vom Pixelwert abhangig ist. Nur
Vor-Kalibrierte *.map Dateien kdnnen importiert werden.

Win GPS Kartenkalibration *.chi Datei kann importiert werden. Liegt die Karte als BMP-Format vor,
kann sie direkt von SeaClear gelesen werden. Eine Kalibrierungsdatei fir alle Karten wird im selben
Verzeichnis wie die bestehende *chi-Datei angelegt. Nach einem Import aller Karten und der
Kalibrationsdatei konnen diese direkt verwendet werden.

GMB Dateien kénnen umgeschrieben werden. Eine bestehende IN8-Datei wird in das neue WCI-
Format tbernommen. Der Mal3stab muss dabei manuell eingegeben werden. Falls aber alle
Kartendateien in einem Verzeichnis liegen ist dies nur bei der ersten Karte nétig. Die weiteren
Karten werden angepasst.

MapCal kann viele Bildformate in WCI umwandeln um von SeaClear genutzt werden zu kénnen.
BMP, PNG, GIF, TIF, JPG, PCX und viele weitere kdnnen umgeschrieben werden. SeaClear kann
nur BMP, PNG und GIF Dateien direkt einlesen, andere Formate miissen zuerst als WCI-Format
umgeschrieben werden.

W(CI Dateien kénnen als BMP (mit den Kalibrationsdaten) und zuriick, umgewandelt werden. Damit
kann eine Nachbearbeitung (z.B. in Paintbrush) durchgefiihrt werden.

Um ein Automatisches Laden der Karten zu erméglichen, nutzt die Datenbank Kartenlayout und
MalRstab. Diese Datenbank wird von MapCal erstellt und muss up(ge)dated werden, falls eine
existierende oder neue Karte nach-/kalibriert wird. Welches Karton-Datum verwendet wurde, wird
ebenso geprift (z.B. Berechnung nach WGS 84).

Karten installieren

Folgende Schritte sind nétig um eine Karte fiir SeaClear zu installieren (um BSB Karten zu
installieren siehe weiter unten).

1: Momentan unterstitzt SeaClear Fixed grid, Mercator, Transverse Mercator, Polyconic, Lambert
Conformal Conic und Sinusoidal projizierte Karten. Projektionen basierend auf Transverse
Mercator, wie UTM und Gauss, werden ebenfalls unterstitzt. Die meisten Projektionen sind bei
kleineren Karten recht brauchbar und genauer als fir die Navigation benétigt. Fast alle Flachbrett-
scanner kénnen benutzt werden und sollten die Karte farbig darstellen. Scannen sie eine
Papierkarte oder “frieren” sie eine Geladene vom Bildschirm. Bestimmt sind am Anfang einige Test
ndtig um die Genaue Ausrichtung, die Bildbrillanz und den Kontrast einzustellen. Die Datei sollte
als unkomprimierte BMP oder komprimierte PNG (Palette Format mit max. 256 Farben)
gespeichert werden. BMP Dateien kdnnen nachbearbeitet werden, lassen aber keinen
Nachtmodus in SeaClear zu. Falls sie also die Datei nicht ins WCI Format (ilbernehmen wollen,
sollten sie diese als PNG oder GIF speichern. Natirlich kénnen mehrere, leicht tiberlappende
eingescannte Bilder zusammen-“geklebt” werden. Eine Auflosung von 100 bis 250 DPI wird
vorgeschlagen. Bei einer Gré3e von 2000 * 2000 Pixel bendtigen sie also alleine 4 MB
Arbeitsspeicher zum Laden, wahrend der Festplattenspeicher vom Datei-Format abhangt.
Speichern sie die gesamte Karte unter ..\SeaClear\Charts.

Wie einfach dies mit bereits digitalisierten Amtl. Seekarten kostenlos funktioniert verrat der
CoAutor — siehe: http://www.skipper-udo.de/SeaNavCD.html
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2. Starten sie MapCal_2.EXE. Mochten sie das WCI Format nutzen, klicken sie Tools->Convert->
Single file to WCI um die Karte als WCI Format umzuschreiben.

3: Offnen sie die Orginal- oder WCI Datei mit "File->Open Image" im Verzeichnis
.\SeaClear\Charts".

4: Sollte sich das Karteninformationsfeld nicht automatisch 6ffnen, rufen sie es mit "Edit->Chart
Information" auf, um einen Kartennamen (der nicht dem Dateinamen entsprechen muss), MaR3stab,
Projection und Karten datum, einzutragen. Weitere Info-Angaben sind optional. Sollte Lat Shift
oder Long Shift genutzt werden, wird die Chart Datum Einstellung tberschrieben. Entnehmen sie
alteren Papierkarten die Korrekturhinweise inwieweit flir den GPS Gebrauch die Karte versetzt
werden soll. Neues Kartendatum ist dann WGS 84. Latitude 0 ist Null fir die meisten Karten,
warend Longitude 0, das “central meridian” der Transverse Mercator, Polyconic, Lambert and
Sinusoidal Projection ist und ein Wert nahe dem Karten-Lon eingetragen werden soll. Falls nicht
bekannt, lassen sie ihn auf 0 und MapCal wahlt diesen fir sie. Falls die Lambert Projection
gewabhlt wird, sollte Nord oder Sid eingestellt werden. Ist dies nicht bekannt, belassen sie die 0
und MapCal wahlt die Normaleinstellung. Priority (Vorrang) wird fir das auto-loading genutzt,
wobei 1 der héchsten Vorrangstufe entspricht. Eine Prioritat von 10 entspricht dem halben
Malstab, somit ist ein 1/25000 MaRstab mit Prioritat 10 gleich einer Karte mit Maf3stab 1/50000
der Prioritat 1. Bendtigen sie keinen “auto-load”, die Karten sollen aber in der Liste auftauchen,
benutzen sie eine héhere Prioritdtsnummer.

5: Setzen sie mindestens 2 Kalibrierungspunkte an bekannten Positionen der Karte, soweit
moglich in gegentliberliegenden Ecken und tragen die Lat/Lon Daten ein. Ausgenommen fiir Fixed
und Mercator Projektionen, bendtigen sie mindestens 3 Punkte. Dazu setzten sie den Cursor auf
die gewulinschte Position und klicken Rechts. Wahlen sie “add new calibration point’. Mit einem
Linksklick und halten kénnen sie diesen Marker verschieben oder nutzen die 4 Pfeile fiir eine
Nachjustierung. Tragen sie nun die korrekten Lat/Long Daten ein. Mit Linksklick und halten in der
Karte oder dem Rollbalken verschieben sie die Karte zum nachsten Punkt. Wiederholen sie die
Prozedur Rechtsklick “add new...” und tragen die dazugehorigen Daten ein. Bei geklebten Karten
empfiehlt es sich mehrere Punkte zu vergeben. Die Reihenfolge ist dabei unwichtig.

6: Im Rollmeni Grid (Gitter) wahlen sie nun “Normal Grid” und bestatigen dies mit "Activate
Changes". Um die Farbe des Gitters zu andern, klicken sie auf das momentan pinkfarbene
Kastchen. Stimmt das Gitter mit der Originalkarte tberein, sind sie fast fertig. Falls aber das Gitter
nicht optimal Ubereinstimmt, wahlen sie Uber das Rollmenu “Callibration Point’ einen Punkt aus
und verschieben ihn wie gewohnt oder weisen sie weitere zu. Werden Punkte nur verschoben
berechnet MapCal bereits die neuen Lat/Lon Werte, die mit "Activate Changes" sichtbar gemacht
werden. Die Kalibration muss abgeschlossen sein, bevor Schritt 7, der Kartenrahmen als
Weltkoordinaten gespeichert wird.

7: Klicken sie am linken Bildschirmrand auf den Reiter “Border’ um einen Kartenrand einzustellen.
Randpunkte werden genauso wie Kalibrierungspunkte eingegeben. Oder klicken sie nur "Set
Border to Image" um einen Rahmen von 5 Punkten zu erhalten. Dies wiirde aber auch automatisch
erfolgen, falls sie nicht einen abweichenden Rahmen eingeben.

8: Sichern sie die Kalibration mit File->Save Calibration.

Das sollte alles sein was sie machen missen. Nach dem Kalibrieren neuer Karten, ibernehmen
von alten SeaClear 1 Kalibrationen, hinzufiigen von vorkalibrierten Karten wie BSB/KAP oder der
Anderung eines Kartenpfades muss die Auto-load Liste erstellt oder updated werden. Dazu klicken
sie Tools > Autoload List > update (evtl. auch bei einigen Formaten recreate). Die Auto-load Liste ist
nétig um in SeaClear die richtige Karte automatisch laden zu kénnen.
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MapCal Referenzen

Beachte: Da es fir MapCal keine Sprachulbersetzung gibt sind nur die Funktionen tbersetzt

File Menu.

O Open Image: Offnet fast jede Bilddatei, Kalkulationsdaten werden, falls vorhanden automatisch geladen.
O Open From List: Wahle eine Karte der Auto-load Liste. (Falls bereits erstellt)

O Save Calibration: Sichert Kalibrationseinstellungen (Falls erstellt).

Edit menu:

O Chart Information: Offnet das Karten Info Fenster. Tragen sie hier MaRstab, Projection und Karten Datum
ein. Der Rest ist optional. Siehe dazu Schritt 4. Das Fenster wird beim Laden von neuen Karten automatisch
geoffnet. Sie kdnnen hier aber auch nachtraglich Anderungen vornehmen und mit save cal. — speichern.

Tools menu:
Das Convert Menu ist fiir das Umschreiben in andere Formate.
O Convert ->Current to WCI: Konvertiert die geladene Karte und der Kalibration in WCI Format.
0 Convert ->Current WCI to BMP: Konvertiert die geladene WCI Karte und der Kalibration in BMP Format.

O Convert->Single file to WCI: Konvertiert Einzelbilddateien als WCI. Die meisten Bildformate kénnen als WCI-
Format konvertiert werden, auch viele Formate die nicht von MapCal oder SeaClear direkt gelesen werden. Sie
sind evtl. nicht kalibriert.

0 Convert->Images in Dir to WCI: Konvertiert alle Bilddateien eines Verzeichnisses. Die Karten sind evtl. nicht
kalibriert und missten einzeln im WCI Format nachkalibriert werden.

O Convert->MAP in Dir to WCI: Konvertiert alle OziExplorer MAP und Bild-dateien als kalibrierte WCI Datei.
Import Cal menu dient dem Import von Kalibrationsdaten in ein hier genutztes Format.

O Import Cal->Old SeaClear Calibration: Importiert alle gefundenen Kalibrationen der alten SeaClear Version.
Der Pfad muss angegeben sein und die seachart.dir Datei in diese verschoben werden. Dabei aber werden bei
Karten mit demselben Karten Dateinamen, die neue Kalibration Uberschrieben.

O Import Cal->CHI Calibrations: Importiert alle Kalibrationsdaten der WinGPS .chi Dateien.
Mit der Autoload List menu wird die SCAINDEX.BIN Datei erneuert.

O Autoload List->Scan for New Charts: Sucht nach neuen Karten im Karten-Verzeichnispfad. Autoload List-
>Update: Sucht nach Kalibrations-Anderungen und neuen Karten im Kartenverzeichnis. Karten-daten die nicht
gefunden werden verbleiben in der Liste (z.B. sie nutzen ein CD Laufwerk haben aber keine CD eingelegt).

0 Autoload List->Recreate: Loscht die alte SCAINDEX.BIN und schreibt eine Neue und sucht dabei in allen
angegebenen Kartenpfaden. Nur tatsachlich gefundene Karten sind in dieser neuen Liste.

Maintenance.

O Remove Unused Calibrations: Léscht unbenétigte Kalibrierungen falls Karten ohne eingearbeitete
Kalibrierung aus dem Verzeichnis entfernt wurden.

Mit Set Directories kénnen alle von MapCal und SeaClear genutzten Kartenpfade eingestellt
werden.

O Set Directories: Stellt den bendtigten Pfad ein und erneuert die SEACLEAR_2.INI Datei.

<<

Klappt das Eingabe-Fenster nach links um das Kartenfenster zu maximieren. Um es erneut
anzuzeigen ziehen sie nur die Mouse wieder an den rechten Rand.
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Installieren von Vor-Kalibrierten Karten

SeaClear ist vorbereitet um normale BSB/KAP und GEO/NOS Dateien sofort zu nutzen. Um sie aber
in der Kartenliste aufzufiihren und zum automatischen Laden, missen sie eingetragen werden.
Nichteingetragene aber kalibrierte Karten kdnnen in SeaClear mit “File->Chart->Not Listed geotffnet
werden.

Installieren von BSB Karten

Das BSB/KAP Dateiformat ist lizenziert von MapTech. Die BSB/KAP Version 1 — 3 wird unterstitzt.
Projektionen basierend auf Mercator, Transversal Mercator, Polyconic, Lambert Conformal Conic
und Sinusoidal sind standig verwendbar.

Karten fur die meisten Gebiete der Erde stehen von Maptech, NDI und anderen Anbietern zur
Verfugung. Das aktuelle Kartenbild ist die KAP Datei, wahrend die BSB Datei nur Kalibrierungs-
Daten enthalt. Da SeaClear seine eigene Datenbank nutzt sind BSB Daten nicht nétig.

Bevor die BSB/KAP Karten von SeaClear genutzt werden, sollten sie registriert sein:

Starten sie MapCal und stelle sie sicher, dass alle KAP Dateien im Karten-Verzeichnis abgelegt
sind. Vom Hauptmenu wahle sie nun “Tools-> Autoload list-> Scan for New Charts”. Die KAP
Dateien werden nun nach Name, Abdeckung und anderen Daten durchsucht und in der SeaClear
autoload database aufgelistet.

Installieren von GEO/NOS Karten
Nur Projektionen basierend auf Mercator, Transversal Mercator, Polyconic, Lambert Conformal
Conic und Sinusoidal werden standig unterstutzt.

Die aktuelle Karte ist eine NOS Datei, wahrend die GEO Datei nur Kalibrationsdaten und
Allgemeines beinhaltet. Beide, die GEO und die NOS Datei sind nétig und missen im selben
Verzeichnis abgelegt sein. Bevor die GEO/NOS Karten von SeaClear genutzt werden, sollten sie
registriert sein:

Starte MapCal und stelle sie sicher, dass alle GEO und NOS Dateien im Karten-Verzeichnis
abgelegt sind.

Vom Hauptmeni wahle sie nun “Tools-> Autoload list-> Scan for New Charts”. Die GEO Dateien
werden nun nach Name, Abdeckung und anderen Daten durchsucht und in der SeaClear autoload
database aufgelistet.

Installieren von WCI Karten
Starte sie MapCal und stellen sie sicher, dass alle WCI Dateien korrekt kalibriert und im
Kartenverzeichnis liegen.

Vom Hauptmenu wahlen sie “Tools->Autoload list-> Scan for New Charts”. Die WCI Dateien
werden nach Name, Eck- und anderen Daten abgesucht und in SeaClear aufgelistet.

Die WCI, KAP und NOS Dateien sind disk mapped, von einer CD herabgeladen ergibt sich daraus
eine langsamere Verarbeitung, weshalb eine Speicherung auf der Festplatte empfohlen wird.
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Hinweise

SeaClear Installation

Installation auf die Festplatte

Das Automatisierte Installationsprogramm legt standardmaRig SeaClear auf der Festplatte ein neues
Verzeichnis in C:\Programme mit Unterverzeichnissen fir "CHARTS", "ROUTES", "TRACES" und
"WAYPTS" an:

<Base Dir>:
SeaClear_2.Exe
MapCal_2.Exe
Datums2.Ini
<Base Dir>\Charts:

World.WClI

Med.WClI

USA.WCI

Sweden.WCI
<Base Dir>\Routes:

(Laden und Speichern sie ihre Routen hier)
<Base Dir>\Traces:

(Traks werden hier automatisch gespeichert)
<Base Dir>\Waypts:

(Laden und Speichern sie Wegepunkt hier)
In Zukunft werden die, SCAINDEX.BIN und SEACLEAR_2.INI automatisch erstellt.

Start der SeaClear Software von einer CD

SeaClear kann von einer CD geladen werden, aber, da CD-Laufwerke nur “Leselaufwerke” sind
kann nichts gespeichert werd. Die "SEACLEAR_2.INI" Datei muss im selben Verzeichnis wie die
SeaClear_2.exe liegen, deshalb wird empfohlen diese auf der Festplatte abzulegen. Disk mapped
Karten (WCI/KAP) werden langsamer verarbeitet, wenn sie von einer CD gelesen werden.

Wie auch immer, da Karten einen gro3en Speicherplatz bendtigen kann SeaClear von der Festplatte
und die Karten aus dem CD Laufwerk geladen werden.

Mit den neuen Speichermedien (MMC, SD...) oder USB Sticks kann SeaClear auf jedem Win 98 SE
bis Win7 basierenden Betriebssystem, direkt von diesem Speicher mit den dazu nétigen Karten
gestartet werden. SeaClear schreibt keine Dateien nach Windows und lauft nachdem sie das ganze
Verzeichnis auf diesen Speicher geladen haben auf jedem Windows Rechner. Evil. mussen sie aber
mit MapCal >Tools >Set Directories den Laufwerksbuchstaben éandern, da dieser von PC zu PC
anders vergeben wird.

Gebrauch von mehreren Karten Verzeichnissen

Da CD-Laufwerke oft sehr langsam arbeiten, konnen oft verwendete Karten auf der Festplatte
abgelegt werden und selten genutzte verbleiben auf der CD. Offnen sie MapCal >Tools >Set
Directories und geben (z.B.) folgende Zeile ein:

"Chart Dir=C\SEACLEAR\CHARTS\;D:SEACLEAR\CHARTS\;D:\MOREMAPS\" (sollte SeaClear in
einem Unterverzeichnis liegen missen sie dieses mit angeben. Beispiel:
c:\Programme\SeaClear\Charts\;D:SeaClear\Charts....)

Alle Karten die nun in den Verzeichnissen C:\SEACLEAR\CHARTS, D:\ SEACLEAR\CHARTS und
D:\MOREMAPS liegen werden im Kartenfenster angezeigt.

Karten, die in diesem Pfad nicht aufgefiihrt wurden, konnen ebenfalls angezeigt werden, wenn sie
mit MapCal kalibriert und installiert wurden.
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De-Installierung

Alle Dateien die installiert und erstellt wurden liegen im Verzeichnis SeaClear. Es wurden keine
weiteren Dateien aullerhalb dieses Verzeichnisses erstellt. Um SeaClear zu entfernen, 16schen sie
einfach das ganze Verzeichnis und die erstellten Shortcuts.

Bei der Vollinstallationsversion benutzen sie Windows Start > Systemsteuerung > Software und
wahlen den Schalter Andern/Entfernen an. Bestatigen sie das Deinstallieren mit Ja.

Technische Informationen

Der Computer

Ein PC mit Windows Win7/Vista/XP/2000/NT oder 95/98/ME. Einige Einschrankungen in Windows
95/98/ME lassen Win7/Vista/XP/2000/NT die besser Wahl erscheinen, vermeidet kleinere Probleme
und erlaubt darliber hinaus weit groRere Karten zu laden.

Minimum 800 * 600 Bildschirm. 1024 * 768 wird bevorzugt um alle Informationen der
Navigationsleiste anzeigen zu kénnen.

Mouse.
1 freier Serieller oder USB- Port fir das GPS.
Pentium+ oder vergleichbarer Prozessor.

Min 32 Mb RAM memory. 64 Mb (abhangig vom OS), wird erwartet und beschleunigt das
Kartenlesen.

PNG Dateien sind langsamer zu lesen und benétigen mehr Arbeitsspeicher, Pentium und 64 Mb
wird empfohlen.

10 - ??7?? Mb freien Speicherplatz auf der Festplatte. (4 Mb fiir SeaClear und ? Mb / Karten). Jede
Karte ist in der Regel eine recht grofle Bitmap. Falls Ihr Windows flir mehr als 256 Farben eingestellt
ist, bendtig der PC zu Erzeugen der grof3en Bitmaps viel Arbeitsspeicher und verlangsamt das
System. Es wird deshalb empfohlen Windows auf max. 256 Farben einzustellen, selbst wenn das
Video Subsystem mehr erlaubt. Dies ist teilweise fir W95/98/ME wichtig und wirkt sich auch auf
PNG-Dateien aus, da diese einmal entpackt einen weit gréReren Arbeitsspeicher bendtigen als
gepackte (Format-verdichtete) auf der Festplatte. Bei disk mapped Karten (WCI & KAP), wird nur der
sichtbare Teil der Karte geladen und hat damit weit weniger Zusammenhang mit dem Windows
Setup.

Alle Versionen von Windows haben eine 32K Begrenzung auf Bilddateien, womit die maximale
KartengroRe auf 32K * 32K begrenzt ist und auch die maximale ZoomgréRe reduziert. So kénnen
nur Karten mit weniger als 8K * 8K bis auf 400% vergrofiert werden.

Ausdrucke von groen Karten sind oft nur mit Windows NT/2000 oder besser maoglich.

AnschluB des GPS und anderer NMEA talkers

Das GPS muss einen NMEA OUT Ausgang haben (Zeichensatz NMEA 0183 RMC, RMA oder

GGA / GLL & VTG). Falls das GPS auf verschiedene NMEA 0183 Versionen eingestellt werden
kann, wahlen sie NMEA 2.0. Altere Versionen von 0183 arbeiten evtl., sind aber nicht besonders
geprift. Schlagen sie in ihrem GPS-Handbuch nach, wie es an einen PC angeschlossen werden
kann. Da NMEA fiir das “serial port data setup” spezifiziert ist (mit Ausnahme des korrekten PC-
Com-ports), sind weitere Einstellungen normalerweise nicht ndtig. Das GPS muss nur mit Rx und
Masse an den PC angeschlossen werden (Ausnahme sie mochten Wp-Dateien and das GPS
zurlickschicken = Tx). Ein 9-pin-Anschluf3 (RS 232 oder Com1 Port), haufig bei alteren Laptops
genutzt, ist folgendermallen belegt , Pin 2=Rx, 3=Tx, 5=Masse. Bei den meisten Markttblichen GPS
Geraten wie Magellan, Garmin und MLR funktioniert dies problemlos.

Wird eine GPS Mouse via USB installiert wird ein ComPort ( i.d. Regel Com3 bis 12) simuliert. Dies
wird bei der Installation der GPS Mouse angezeigt. Stellen sie den korrekten Port unter SeaClear
Bearbeiten > Einstellungen > Com Uber den dortigen Rollbalken ein. Die Baud-Geschwindigkeit
bleibt dabei unverandert auf BPS 4600.

NMEA RMC, GGA, GLL, DBT, VTG, VWR, VWT, MWV, MWD, VHW, HDM, HDG, HDT, ZDA, RMA,
MTW, DTM, VDM und DPT Datensatze sind entschliisselt.
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Anschluss eines NMEA Empfangers

Ein NMEA Empfanger, wie z.B. ein Autopilot muss folgende NMEA Zeichensatze interpretieren
kénnen. APA, APB, RMB, BOD, BWC, WPL und RTE. Schlagen sie in ihrer Betriebsanleitung nach,
wie dieses Gerat an einen PC angeschlossen wird. Da NMEA fiir das “serial port data setup”
spezifiziert ist, muss keine Einstellung verandert werden. Der PC Ausgangs-port ist derselbe den
das GPS als Eingang nutzt. Der Empfanger ist an Tx und Masse mit dem PC verbunden. Da beides,
die Richtung und der maximale XTE-Fehler an den Autopiloten Ubermittelt werden, kann dieser recht
genau die vorgegebene Routenlinie halten. Die empfangenen NMEA-Meldungen werden Uber den
Ausgang weitergeleitet.

Kalkulation und Genauigkeit

Richtung und Entfernung werden als “rumbline” kalkuliert. Alle Kalkulationen werden mit doppelter
Prazision berechnet um Mathematische Fehler zu eliminieren. Bei gréReren Distanzen ist die
“rumpline”-Berechnung etwas ungenauer wie in der “arcepelago” (Grol3kreisberechnung) Navigation.
SeaClear kann nicht mit Karten arbeiten, welche die Datumslinie Gberspannen (180 E/W)

WCI Datei Format

Das neu geschaffene Dateiformat WCI (World Calibrated Image) wird unterstitzt. Es erlaubt “disk
mapping” (s. dort), beinhaltet Welt Kalibration Daten und kann aus ihren bestehenden Karten-
Dateien erstellt werden. Es komprimiert recht gut und erlaubt eine Nachkalibrierung. WCl ist ein
“palette Format” das bis zu 256 Farben und eine maximal Grofl3e von 32767 * 32767 Pixels und 1Gb
erlaubt. MapCal kann zur Erstellung von WCI Files genutzt werden. Nur “palette”-Bilder kbnnen
umgerechnet werden. Dieses Format arbeitet ausgezeichnet mit groRen Karten mit geringerer
Farbtiefe. Um beste Resultat damit zu erzielen sollte die Karte weniger als 64 Farben und grof3e
einfarbige Flachen haben.

Disk Mapping

Disk mapping wird von WCI, BSB/KAP und GEO/NOS Dateien genutzt. Es erlaubt die Arbeit mit
riesigen Bitmap-dateien. Dateien im nicht verdichteten Zustand von Uber 150 MB wurden getestet
und arbeiten sogar mit Systemen mit begrenztem Memory. Falls mdglich sollten diese Dateien nicht
direkt vom CD-Laufwerk geladen werden, da sie erneut beim jedem Bildschirm-Update eingelesen
werden. Beim Zoomen macht sich ein geringer Zeitverzug bemerkbar, da die Bildschirmdarstellung
mit dem Originalbild verglichen und standig nachgerechnet wird.

Karten Datei Formate

SeaClear ist entwickelt um den vollen Gebrauch von “disk-mapped” Formaten machen zu kénnen.
Aber auch PNG oder BMP Karten kédnnen weiterhin genutzt werden. Da Karten Kalibrationsdaten
bendtigen, werden diese in einer separaten Datei im selben Verzeichnis gespeichert, wahrend KAP
und WCI eingebundene Kalibrationsdaten in der jeweiligen Datei haben. BMP erstellt sehr grolRe
Dateien und kann nicht fir den Nachtmodus abgedunkelt werden. PNG verdichtet recht gut.
Kalibrierte PNG und BMP Bilddateien kénnen in WCI Formate umgewandelt werden. MapCal kann
auch viele weitere Bildformate in WCI-Formate, zum Gebrauch von SeaClear umwandeln.

Magnetische Missweisung

SeaClear kalkuliert automatisch die Missweisung fir das aktuelle Seegebiet. Die Kalkulation basiert
auf die meisten zuganglichen Daten, um das beste Resultat zu erzielen. Magnetische Anomalien
sind nicht mit einbezogen. Um eine Programminterne Berechnung abzuschalten und die vom GPS
gelieferte Missweisung zu nutzen, sehen sie bitte unter SeaClear_2.INI Datei Einstellungen nach.

26



SeaClear MMV

Gebrauch von G7ToWin fiir den Datenaustausch mit einem GPS

SeaClear kann mit der Fremdsoftware g7toWin arbeiten.

Beachte: Einige GPS Gerate bendtigen eine NMEA-Protokolumstellung um mit G7ToWin Software
Daten austauschen zu kdnnen. Die G7ToWin Version A.00.140 wurde getestet, neuere Versionen
sollten ebenfalls funktionieren.

1: Speichern sie eine Kopie von G7ToWin.exe in dasselbe Verzeichnis in dem die SeaClear_2.exe
liegt.

2: Starten sie G7ToWin und richten sie die Ubertragungseinstellungen zum GPS ein. Priifen sie die
Funktion und speichern sie die funktionierende Einstellung. Beenden sie G7To Win.

3: Starten sie SeaClear. Das GPS Mend ist nun in SeaClear eingebunden. Wegepunkt und Routen
kénnen von und an das GPS, Tracks kbnnen vom GPS an SeaClear geschickt werden.

Sollen Daten von SeaClear an das GPS geschickt werden, legt SeaClear eine Datei im *.g7t Format
an. Mit einem aktivierten G7ToWin werden diese Daten an das GPS lbermittelt.

Um Daten eines GPS zu erhalten wird zuerst die Software G7ToWin aktiviert. Diese legt eine Datei
im *.g7t Format an die von SeaClear importiert werden kann Datei > Wegepunkte > Import. Fir
den Download von Tracks (Verlaufsspur) eines GPS werden die letzten Trackpunkte als Datei
abgelegt. Diese Datei sieht etwas so aus: "20060603-g7t (1).trc". Die voribergehend angelegte
Datei (temporary g7t) ist immer "$$g7t0$$.g7t" und liegt im SeaClear Verzeichnis. Jede Mitteilung
wahrend das GPS Daten Gbermittelt, wie "Error More then 30 points - Rest are skipped" wird von
G7ToWin hergestellt. SeaClear erhalt keine Riickmeldung auf Fehler. Falls wahrend des Empfangs
nichts dargestellt wird ist ein Fehler aufgetreten. Alle in SeaClear dargestellten Wegepunkte (ob dort
gesetzt oder vom GPS erhaltene) beziehen sich auf das WGS-84 datum. Stellen sie also sicher,
dass im GPS, G7ToWin und dem GPS Setup WGS84 eingestellt ist. G7ToWin DDD, DMM und
DMS Wegpunkt-Format wird beim Import unterstitzt. Alle Exportierten Daten sind im DMM Format.

"Ziel Fahigkeit " (ob und wie das GPS Daten verarbeiten kann) werden im SeaClear Setup
eingestellt. Stellen sie sicher, dass die Einstellungen mit ihrem GPS (bereinstimmen.

G7ToWin und Waypoint+ Datei Unterstiitzung

G7ToWin und Waypoint+ text Dateien werden fir Import und Export unterstiitzt. Die Dateiendung
gibt Auskunft iber den genutzten Dateityp. Dateien von G7ToWin mussen eine *g7t Endung haben.
Waypoint+ files sind im plain-text Format und haben eine *.txt Endung (die jeder Editor lesen und
erstellen kann).

Nacht (Abdunkelungs-) Mode

SeaClear kann die Abdunkelung der Karte, falls diese im PNG, WCI oder KAP Dateiformat

gespeichert ist, vornehmen. Bei PNG Dateien wird dies beim Laden der Datei vorgenommen und

andert es bevor die Karte dargestellt wird.

Bei WCI und KAP wird die geladene

s : ; Farbpalette gedndert, somit ist ein erneutes
Darstellung im Machtmodus ’ e | Laden niCht nOtWendig.

I oG NIl  Vier Modi kdnnen im System Meni gewahit
dacht mit Fahririchtung i t werden. Normal, Dd&mmerung, Dunkelheit
Ertfernungsringe
und Nacht.

Der Normalmodus unterliegt keiner
Anderung. Die anderen drei
Abdunkelungen kdénnen im Einstellungs-
Setup Prozentual von 0-95 eingestellt
werden, wobei der Wert 0 keine Anderung
ist. Eine Negative Prozentzahl kehrt die
Farben vor dem Abdunkeln um.

Die Windows Oberflache kann dabei mit
einbezogen werden und wird Uber
Einstellungen aktiviert.

Peilcursar
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Sprache

Wahlen sie eine Sprache

Uber Tools > Properties > Display > Language > ... kdnnen sie aus dem gedffneten Fenster eine
neue Sprache (z.B. German_2.LNG) wahlen. Der meiste Text (mit Ausnahmen von MapCal) ist
Ubersetzt und die Sprachauswahl wird gespeichert.

Erstellen einer Sprachdatei

1: Offnen sie die ENGLISH_2.LNG Datei mit einem Texteditor (z.B. Notepad) und speichern diese
als erstes unter einem neuen Namen (z.B. meine_sprache.LNG).

2: Benutzen sie den Texteditor weiter. Alle Textteile haben einen Schliissel und eine Aussage:

' Form.XTELabel.Hint=Crosstrack Error'. Der Schliissel steht links vom =Zeichen. Andern sie diesen
NIE. Die Textaussage steht rechts vom =Zeichen. Arbeiten sie sich durch die Datei und andern sie
dabei ihre Ubersetzung ein. In Meniis, genau am &Zeichen wird ein shortcut erstellt (im Menue dann
unterstrichen). Beginnt ein Text oder endet mit einem Leerzeichen, belassen sie dieses und
beenden den Text. (Beispiel: _Form.TX_MESSAGES.Lines.31="is not saved! Save?). Beginnen sie
keinen Text mit einer Zahl, - oder _. Die Kopfzeile "[Text_2]" muss die erste Zeile in der Datei
bleiben. Vergessen sie das Abspeichern nicht!

3: Wahlen sie die neue Sprache wie oben angegeben.
4: Prifen sie ob der Text in den zur Verfigung stehenden Platz passt!

Bitte senden sie neue Sprachibersetzungen an: 06.seaclear@sping.com damit diese weitergegeben
werden konnen.

Beachte: Nur ANSI Zeichen kénnen genutzt werden.

Beachte: Eine Vorlage Datei kann durch ,save“ vor dem Dateinamen im Setup angehangt werden (z.B.
“save:C:\SC\LANG.LNG”). Statt eines Ladens dieser Datei wird diese nun (ohne das ,save®) bereitgestellt. Alle gegenwértigen
Anderungen sind dabei enthalten.

Geodetic Karten Datum

Das angeschlossene GPS sollte so eingestellt sein, dass es das WGS 1984 Datum bermittelt. Falls
nicht, berichtigen sie im Einstellungen-Fenster das korrekte Datum. Die aktuelle Position wird dann
auf die Basis WGS 84 (ibersetzt. Alle internen Berechnungen basieren auf diesem Datum.

Falls Karten mit einem anderen Datum als WGS 84 gebraucht werden, muss die Karte normal
kalibriert werden und mit dem Gitternetz Ubereinstimmen. Das im Infofenster angegebene
GeoDatum wird dann verwendet um die korrekten Positionen fir WGS 84 umzurechnen mit dem
SeaClear arbeitet. Alle Positionen wie Schiff, Wegepunkt und Traks werden dann umgerechnet.

Alle Karten des Geo-datums sind in der Datums2.INI Datei gespeichert. Nachkalibrierte Karten
beziehen sich oft auf dasselbe Datum, verwenden sie also verschiedene Kartennamen. Wahrend
der Erstellung der Autoload Liste wird das Kartendatum geprift und Nachkalibrierte Karten
unterscheiden sich nur in verschiedenen Karten Datums. Die Unterscheidung wird in der
[DatumsAliases] Abteilung gespeichert

Karten Projektionen

SeaClear unterstltzt Mercator, Transversal Mercator, Polyconic, Lambert Conformal Conic,
Sinusoidal und Fixed Grid Projektionen. Viele Projektionen basieren auf Transverse Mercator wie
UTM, Gauss Kruger und viele andere werden ebenfalls unterstitzt. Die Projektion wird wahrend der
Installation ausgewahlt. Falls der Zentral Meridan (Lon0) fiir die Transversal Projektion nicht bekannt
ist, nutzen sie die Kartenmitte. Die Latitude des Orginales (Lat0) ist selten etwas anderes als 0. Fur
Lambert Projektionen miissen die Std- und Nord Standart Parallelen bekannt sein. Wird die
Projektion gedndert muss die Kalibration tUberprift werden.

Weitere Variationen von Mercator, Transversal Mercator, Polyconic, Lambert Conformal Conic,
Sinusoidal kénnen der Datum2.INI Datei angehangt werden.

Die [Projektions] Abteilung ist flir Gebraucher-Projektionen vorbereitet.

Name=Base,Lat0,Lon0, LatS, LatN wobei der Name in der Rollliste angezeigt wird, Base 1 fiir
Mercator, 2 fiir Transverse Mercator, 3 fir Lambert, 4 fiir Polyconic und 5 fiir Sinusoidal. Lat0 ist
Latitude des Ordinales, LonO ist der Zentrale Meridian. Falls benétigt, wird die Rollliste in der base
Projektion verandert. Lat0 und Lon0O werden mit den eingegebenen Werten ersetzt.
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Beachte: Das GPS System arbeitet mit WGS 84 geodetic datum und Umrechnungen sind nicht exakt.

AIS Signale

Wird ein AIS- Sende-/Empfanger oder Empfanger angeschlossen kann SeaClear diese, basierend
auf einen méglichen NMEA VDM Binar Datensatz als Ziele darstellen. Es kénnen keine Daten an
das AIS Gerat weitergegeben werden. Alle AlS Ziele werden nach 4 Minuten automatisch geldscht
sobald kein Folgesignal empfangen wird.

AIS Sender werden mit dem HDT Datensatz (soweit vorliegend) dargestellt, sonst mit COG (Kurs
Uber Grund). Sollte das ROT Signal empfangen werden, wird ein Wendekreis angezeigt und der
Geschwindigkeitsradius beim Empfang von ROT Information angezeigt. Der Geschwindigkeitsradius
hat denselben Vorhalt, wie der von ihnen Voreingestellte Speedmarker (Erreichbarer Punkt in *
Sekunden). Die Fahrtrichtung des AIS Zieles wird bei entsprechendem Kartenmalstab angezeigt

Im AIS Rollmeni werden alle AIS Sender dargestellt und bei jedem 6ffnen des Rollmenis

aktualisiert.
AIS Sender. Bei einem Anklicken des Zieles wird die geplante Fahrrichtung falls mdéglich
angezeigt, ansonst zeigt es den COG mit dem Wenderadius. Um weitere AlS Informationen
des Zieles zu erhalten klicken sie Rechts auf das Ziel und wahlen Tools->AlS Info:

UTC: 2005-09-12 23:20:44 UTC Zeit beim Erhalt des Datensatzes.
Name: SHIPNAME Schiffsname

Callld: XXXX Rufnummer

Dest: PORTNAME Zielhafen

SOG: 13kn Geschwindigkeit Gber Grund

COG: 179,3° Kurs Gber Grund

HDT: ?° Geplante Fahrtrichtung, Magnetisch Wahr
ROT: 0°/min Kurswechselrate, Kursanderung in Grad pro Minute
Lat: 12°34.567'N Position

Long: 054°32.109'E

Length: 25m Gesamtlange des Schiffes.

Width: 6m Gesamtbreite des Schiffes.

Draft: 2m Tiefgang des Schiffes

MMSI #: 123456000 Schiffs MMSI Identifizierung

IMO #: ? Schiffs IMO Nummer

RNG 12.345NM Entfernung zum Ziel

BRG 234° Kurs zum Ziel

CPA 1.234NM CPA Kollisionsentfernung

TCPA 00:12.34 Zeit bis zur CPA

Felder mit unbekannten Daten werden mit einem Fragezeichen dargestellt.

CPA und TCPA sind nur berechenbar wenn die Kollision CPA in den nachsten 24 Stunden mdglich
ist.

Das ausgewahlte AIS Signal wird mit einer Raute dargestellt!
AIS Auswahlziel
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CPA Kollisionswarnung auf der Karte.

Wenn sich die CPA (Closest Point of Approach = Nahester Punkt der
Anndherung) und TCPA (Time to CPA = Zeit zum CPA Ziel) der
. Uberwachungszonen nahern wird eine Warnung in Form von 2 sich
! Uberschneidenden Ringen dargestellt. Der eine Kreis ist das eigene
' Schiff mit Berechnung COG (Kurs iber Grund) und der Voreingestellten
CPA Max (Zeit oder Entfernung). Der zweite Kreis ist das gegnerische
AIS Signal (Schiff) mit COG Darstellungsrichtung, Schiffsname und (falls
moglich) der Schiffslangenradius. Die CPA Warnung wird solange
angezeigt wie TCPA (Kollisionszeitpunkt) zwischen 0 und TCPA Max
liegen und CPA kleiner als CPA Max zuzuglich der Schiffslange ist. Die CPA Daten werden dabei
fortlaufend mit allen AIS Sendern, die dargestellt werden, neu berechnet. Sobald eine berechnete
Warnsituation nicht mehr vorliegt, wird sie auch nicht mehr dargestellt. Um Warnsituationen nicht auf
dem Bildschirm angezeigt zu bekommen muss der TCPA Max Wert auf 0 gestellt werden.

EINIMER

SeaClear_2.INI File Settings

Die meisten Einstellungen werden intern von SeaClear vorgenommen. Es ist aber auch moglich
diese Einstellungen mit einem Text Editor zu veréandern. Diese Anderungen sollten nur von
erfahrenen Computerbenutzern durchgefiuhrt werden. Da eine Sprachmischung hier nur verwirrt
verbleibt das Original.

Changable INI file settings (Veranderbare *.ini Dateieinstellungen)

[Program State] section

The section [Program State] is updated by SeaClear and should not be changed, except to reset log
and time. SeaClear must not be running.

To zero the log, delete the key:
Total Distance=XXXX

To zero the time, delete the key:
Time Counter=XXXX

[Program Setup] section

; Use chart numbers in name. For BSB/KAP and GEO/NQOS files, the chart number will

; be added to the chart name. Useful if charts have the same name but different numbers.

; Default is 0, Off. 1 is On. Used by MapCal. If changed you must recreate the Autoload list.
Use Chart Numbers=0

;How SeaClear handles checksums from the NMEA device. Restart SeaClear if changed.
NMEA CheckSum=1

; 0 = Force use of Checksum, empty not accepted

; 1 = Accept empty checksums, use checksum if available (Default)

; 2 = do not check NMEA checksum

; Default warning sound .wav file:

; If no path is specified, it is assumed to be located in the Windows directory.
Sound1=DING.WAV

; To replace default sound with other .wav file:

Sound XTE R=FileName ; For XTE Right Warning Sound

Sound XTE L= FileName ; For XTE Left Warning Sound

Sound NMEA= FileName ; For No NMEA Warning Sound

Sound Dpt=FileName ; For Depth Warning Sound

; To use Magnetic Variation from GPS
MagErr Calc=0

;You can capture selected NMEA sentences to a file. Any NMEA messages may be captured, even
those not used by SeaClear:
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NMEA_CAPTFILE=C:\NMEACAPT.TXT ; Your capture file
NMEA_CAPTMSG=RMC,GGA,VTG,DBT ; Captured messages. Use "*" to capture all messages

;You can simulate the GPS data from a file. No NMEA input may be present:
NMEA_SIMUL=C:\NMEAINP1.TXT

; Changing the WCI/KAP/NOS disk buffer. Default 1/8 of computer RAM, or max 16 Mb. In Kb.
; Should normally not be changed.
Diskmap Buffer=16384

; Changing max WCI image size when full image is loaded in memory. Default set to same as
; Diskmap Buffer. Set to 0 speeds up initial loading time of smaller charts but may slow down
; panning and zooming. In Kb.

Diskmap ImageMem=16384

[Fuel Data] section

Fuel consumption may be estimated. Enter values for speed and fuel consumption/hour in the [Fuel
Data] section as "speed=fuel-consumption". Both speed and fuel/H is entered with times 10 without
the decimal. Speed must be entered with 3 digits with leading zeros. Max 20 entries. The 2 closest
values are used to calculate current fuel consumption. Fuel is displayed in the log and time panel. To
disable fuel display, rename or comment out the [Fuel Data] section.

Sample:

If your boats fuel consumption is as follow:
2.81/h @ 0.0Kt (Idle)

4.51/h @ 5.0Kt

8.01/h @ 8.0Kt

22.51/h @ 14.0Kt

35.0 I’lh @ 18.0Kt

65.0 .h @ 25.0Kt

Enter the following in the INI file:
[Fuel Data]

000=28

050=45

080=80

140=225

180=350

250=650

Command line arguments

SeaClear recognize the following command line arguments:
/Ixxxx where xxxx is the filename of an alternate INI file, including full path.
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SeaClear License

(Wird nicht ubersetzt da nur die Englische Original Version der Lizenz Giiltigkeit hat! Sollten sie sich
nicht mit den Lizenzbestimmungen einverstanden erklaren ist eine Nutzung und jeder weitere
Gebrauch der Software nicht erlaubt)

By using or redistributing the SeaClear Software, you agree to all parts of the SeaClear License.

You are granted a non-exclusive license to use the SeaClear Software subject to the following terms
and conditions:

SeaClear is fully proprietary copyrighted software. Sping AB asserts the right to be recognized as
the owner, author and copyright owner under International Treaty and Copyright Law.

SeaClear is provided 'as-is', without any warranty, expressed or implied. In no event will the author
be held liable for any damages arising from the use of this software.

Local law and regulation may restrict the use of electronic navigation software. Always follow local
regulations and have original charts and appropriate navigation equipment available when using
SeaClear.

SeaClear must never unattended send information to any device controlling the boat.
You may redistribute SeaClear Software to any person or organization provided that:

You do not charge for the SeaClear Software as a stand-alone product, or charge for products
where the SeaClear Software is included without explicit prior written permission from Sping AB.

You do not claim to represent ownership or title on, or affiliation with, the SeaClear Software.
You supply the SeaClear Software package complete and unmodified, including this document.

SeaClear is only a navigational aid. It collects, calculates and displays data for you, but there
is no guarantee it is correct, there are many sources for errors. SeaClear is not a replacement
for navigational knowledge, nor can it navigate by it self. Use it with care. Always have the
original charts available when SeaClear is in use.
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